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Copyright
Copyright © 2008 Lattice Semiconductor Corporation.

This document may not, in whole or part, be copied, photocopied, 
reproduced, translated, or reduced to any electronic medium or machine-
readable form without prior written consent from Lattice Semiconductor 
Corporation.

Trademarks
Lattice Semiconductor Corporation, L Lattice Semiconductor Corporation 
(logo), L (stylized), L (design), Lattice (design), LSC, E2CMOS, Extreme 
Performance, flexiMAC, flexiPCS, FreedomChip, GAL, GDX, Generic Array 
Logic, HDL Explorer, IPexpress, ISP, ispATE, ispClock, ispDOWNLOAD, 
ispGAL, ispGDS, ispGDX, ispGDXV, ispGDX2, ispGENERATOR, ispJTAG, 
ispLEVER, ispLeverCORE, ispLSI, ispMACH, ispPAC, ispTRACY, 
ispTURBO, ispVIRTUAL MACHINE, ispVM, ispXP, ispXPGA, ispXPLD, 
LatticeEC, LatticeECP, LatticeECP-DSP, LatticeECP2, LatticeECP2M, 
LatticeMico8, LatticeMico32, LatticeSC, LatticeSCM, LatticeXP, MACH, 
MachXO, MACO, ORCA, PAC, PAC-Designer, PAL, Performance Analyst, 
PURESPEED, Reveal, Silicon Forest, Speedlocked, Speed Locking, 
SuperBIG, SuperCOOL, SuperFAST, SuperWIDE, sysCLOCK, sysCONFIG, 
sysDSP, sysHSI, sysI/O, sysMEM, The Simple Machine for Complex Design, 
TransFR, UltraMOS, and specific product designations are either registered 
trademarks or trademarks of Lattice Semiconductor Corporation or its 
subsidiaries in the United States and/or other countries. ISP, Bringing the Best 
Together, and More of the Best are service marks of Lattice Semiconductor 
Corporation.

Other product names used in this publication are for identification purposes 
only and may be trademarks of their respective companies.

Limited Warranty
Lattice Semiconductor Corporation warrants the original purchaser that the 
Lattice Semiconductor software shall be free from defects in material and 
workmanship for a period of ninety days from the date of purchase. If a defect 
covered by this limited warranty occurs during this 90-day warranty period, 
Lattice Semiconductor will repair or replace the component part at its option 
free of charge.

This limited warranty does not apply if the defects have been caused by 
negligence, accident, unreasonable or unintended use, modification, or any 
causes not related to defective materials or workmanship.
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To receive service during the 90-day warranty period, contact Lattice 
Semiconductor Corporation at:

Phone: 1-800-LATTICE or (503) 268-8001
E-mail: techsupport@latticesemi.com

If the Lattice Semiconductor support personnel are unable to solve your 
problem over the phone, we will provide you with instructions on returning 
your defective software to us. The cost of returning the software to the Lattice 
Semiconductor Service Center shall be paid by the purchaser.

Limitations on Warranty
Any applicable implied warranties, including warranties of merchantability and 
fitness for a particular purpose, are hereby limited to ninety days from the date 
of purchase and are subject to the conditions set forth herein. In no event 
shall Lattice Semiconductor Corporation be liable for consequential or 
incidental damages resulting from the breach of any expressed or implied 
warranties.

Purchaser’s sole remedy for any cause whatsoever, regardless of the form of 
action, shall be limited to the price paid to Lattice Semiconductor for the 
Lattice Semiconductor software. 

The provisions of this limited warranty are valid in the United States only. 
Some states do not allow limitations on how long an implied warranty lasts, or 
exclusion of consequential or incidental damages, so the above limitation or 
exclusion may not apply to you.

This warranty provides you with specific legal rights. You may have other 
rights which vary from state to state.
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Type Conventions Used in This Document

Convention Meaning or Use

Bold Items in the user interface that you select or click. Text that you type 
into the user interface.

<Italic> Variables in commands, code syntax, and path names.

Ctrl+L Press the two keys at the same time.

Courier Code examples. Messages, reports, and prompts from the software.

... Omitted material in a line of code.

.

.

.

Omitted lines in code and report examples.

[ ] Optional items in syntax descriptions. In bus specifications, the 
brackets are required.

( ) Grouped items in syntax descriptions.

{ } Repeatable items in syntax descriptions.

| A choice between items in syntax descriptions.
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Installing ispLEVER Tools
This chapter provides installation instructions for the ispLEVER® 7.1 software 
for Windows.

During installation, you will be prompted to select the installation path for the 
ispLEVER and global constraints for JEDEC file options.

The ispLEVER software supports LatticeEC™, LatticeECP™, LatticeECP2™, 
LatticeECP2S, LatticeECP2M™, LatticeECP2MS, LatticeXP™, LatticeXP2™, 
LatticeSC™, LatticeSCM™, and MachXO™ designs.

System Requirements
Intel Pentium or Pentium-compatible PC

Windows XP, Windows 2000 Workstation, or 32-bit Windows Vista

Approximately 4.5 GB free disk space

1024 X 768 graphics display

Note

If your operation system is Windows Vista, make sure you have installed all the 
latest patches from Microsoft.
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System Requirements Installing ispLEVER Tools
CD-ROM drive (2X or above) or DVD-ROM drive

Microsoft-compatible mouse and mouse driver

Table 1 lists the minimum memory requirements and the recommended 
memory for the Windows operating system on 32-bit platforms for all the 
Lattice Semiconductor FPGA device families.

Table 1:  Recommended Memory for Windows 32-Bit Platforms

Device Size Minimum Recommended

MachXO All 256 MB 512 MB

LatticeECP, LatticeXP, 
LatticeXP2

Up to 20K LUT 512 MB 768 MB

Up to 50K LUT 768 MB 1 GB

LatticeECP2/S Up to 20K LUT 768 MB 1 GB

UP to 50K LUT 1 GB 1.5 GB

Up to 70K LUT 1 GB 2 GB

LatticeECP2M/S Up to 20K LUT 512 MB 768 MB

Up to 50K LUT 768 MB 1 GB

Up to 70K LUT 1 GB 1.5 GB

Up to 100K LUT 1 GB 2 GB

LatticeSC/M Up to 40K LUT 768 MB 1 GB

Up to 115K LUT 1 GB 2.5 GB
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Installing ispLEVER Tools Contacting Lattice Semiconductor
Contacting Lattice Semiconductor
You can contact Lattice Semiconductor by any of the following means:

Lattice Semiconductor Corporation
5555 Northeast Moore Court
Hillsboro, Oregon 97124-6421 U.S.A.

Internet: www.latticesemi.com

Literature Hotline: 1-888-ISP-PLDS (477-7537)

Applications Support
Domestic: 1-800-LATTICE (528-8423)
International: (503) 268-8001
Fax: (503) 268-8556

Note

The standard Windows platform limits the amount of memory to a maximum of 2GB for 
any ispLEVER program. You can configure the Windows XP operating system to allow 
up to 3 GB of memory usage by adding the /3GB switch to the end of the startup line in 
the boot.ini file. Before you take advantage of this capability, it is important that you 
read the following information:

Microsoft Knowledge Base Article #328269, which addresses a potential problem 
with the /3GB switch. 
Go to http://support.microsoft.com/?kbid=328269.

Microsoft Bulletin Q17193, which explains the 4GT RAM Tuning feature of 
Windows NT Server Enterprise Edition.
Go to http://support.microsoft.com/default.aspx?scid=kb;en-us;Q171793

Microsoft article “Memory Support and Windows Operating Systems,” which 
explains the use of the physical address extension (PAE) for 
Windows XP Professional and Windows Server 2003 Memory Support.
Go to http://www.microsoft.com/whdc/system/platform/server/PAE/PAEmem.mspx

For instructions on modifying the boot.ini file, go to http://support.microsoft.com/
default.aspx?scid=kb;en-us;q289022
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Installing ispLEVER 7.1 Software for Windows
The following sections describe product options and installation instructions 
for the ispLEVER software.

Software Product Options
Table 2 shows the product options for the installation of ispLEVER Design 
Tools.

Table 3 shows the tools included in the ispLEVER for Windows option.

Table 2: ispLEVER Design Tools Installation Options

Product Option Description

ispLEVER for 
Windows

Installs the ispLEVER design tools for all Lattice Semiconductor FPGA designs. 
Table 3 lists the tools included in this option. This option includes subfeatures for 
setting checksum and SVF options.

ispVM System Installs the ispVM® System programming software for multi-vendor device 
programming.

FPGAs Installs Lattice FPGA devices. This option includes subfeatures for installing 
LatticeEC/ECP, LatticeECP2/LatticeECP2S, LatticeECP2M/LatticeECP2MS, 
LatticeXP, LatticeXP2, MachXO, or LatticeSC/LatticeSCM devices.

Synplify® for Lattice Installs Synplicity® Synplify and Synplify Pro® for Lattice Semiconductor synthesis 
software.

Active-HDL® Lattice 
Edition

Installs Aldec® Active-HDL for Lattice Semiconductor simulation software.

Table 3: Tools included in the ispLEVER for Windows Option

Tool Description

Project Navigator Serves as the primary interface for the ispLEVER software to ease project 
management.

Block Modular 
Design Wizard

Guides you from initial design partitioning through parallel development and 
implementation to later reassembly.

Design Planner Provides graphical interface tools for setting constraints and managing FPGA device 
real estate.

Design Entry Tools Includes the Schematic Editor, Text Editor, and Symbol Editor, which offer schematic, 
VHDL, Verilog, EDIF, and mixed-mode design entry support.
4 ispLEVER 7.1 Installation Notice



Installing ispLEVER Tools Installing ispLEVER 7.1 Software for Windows
EPIC Device Editor Provides device editing capability for engineering change management and detailed 
manipulation of FPGA implementation.

Hierarchy Browser 
and Navigator

Enables you to navigate through a design consisting of any combination of schematic 
and HDL modules. 

HTML Help and User 
Documentation

Includes complete instructions for designing with ispLEVER design tools and third-
party tools. Also provides user manuals, tutorials, example design projects, and 
access to technical documentation from the Lattice Semiconductor Web site.

IPexpress™ Enables you to create and instantiate parameterized modules and IP cores for 
FPGAs.

ispLeverDSP 
Blockset

DSP function blockset for use with The MathWorks® MATLAB®/Simulink® design 
environment (available separately from The MathWorks).

Reveal Inserter and 
Logic Analyzer

Generate and integrate logic analysis cores to help you debug a device. They enable 
you to view the switching of internal nodes of an FPGA on-chip during live operation.

Note: Reveal is a next generation FPGA debugging solution which replaces the 
functionality in ispTRACY. The ispTRACY users are recommended to migrate to 
Reveal.

ispTRACY Core 
Linker and Logic 
Analyzer

Generate and integrate logic analysis cores to help you debug a device. They enable 
you to view the switching of internal nodes of an FPGA on-chip during live operation.

Note: The ispTRACY tools are supplied for backward compatibility. It is strongly 
recommended that all new projects use the Reveal software for debugging 
requirements.

Library Manager Enables you to manage libraries of symbols that are used in your FPGA designs.

Performance 
Analyst™

Enables you to measure the performance of designs implemented in Lattice 
Semiconductor devices through static timing analysis.

Power Calculator Calculates the estimated device power consumption. The Power Calculator also 
comes as a stand-alone tool.

Report Viewer Enables you to view, but not edit, the various report files generated by the ispLEVER 
software.

Revision Control 
System

Enables you to manage multiple design revisions of your project.

Tcl/Tk Scripting Tool Enables you to automate ispLEVER design processing.

Table 3: Tools included in the ispLEVER for Windows Option (Continued)

Tool Description
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Installing ispLEVER 7.1 Software for Windows Installing ispLEVER Tools
Apart from the ispLEVER core design tools, additional software options 
shown in Table 4 are available in the ispLEVER Setup window.

Installation Procedure
The ispLEVER 7.1 software can be installed from three ispLEVER CD-ROMs 
or one ispLEVER DVD-ROM.

To install the Lattice Semiconductor ispLEVER software:

1. Close all applications before starting ispLEVER installation.

2. Insert the ispLEVER software CD-ROM 1 or the DVD-ROM into the drive. 
The ispLEVER Setup window automatically appears, as shown in 
Figure 1.

Table 4: Additional Software Options

Product Option Description

PAC-Designer Installs the PAC-Designer® software, which includes all the tools you need for design 
and download of Lattice Semiconductor's Power Manager and ispClock™ device 
designs.

Adobe Reader 6.0 Installs the Adobe Acrobat Reader 6.0 software.

Note

After you insert the first CD-ROM, the software prompts you when you need to 
insert the second or third CD-ROM.
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Installing ispLEVER Tools Installing ispLEVER 7.1 Software for Windows
You can also run <CD-ROM drive>:\setup.exe to start the installation 
program manually.

3. Click Install ispLEVER Design Tools. 

Figure 1: ispLEVER Setup Window
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Installing ispLEVER 7.1 Software for Windows Installing ispLEVER Tools
The Product To Install dialog box opens, as shown in Figure 2.

4. If you want to see a description of the installation components for the 
ispLEVER software and the minimum system requirements, click More 
Information to open the Help file.

5. Click Next to open the Welcome To Lattice Semiconductor ispLEVER 
Setup dialog box.

6. Click Next to open the Software License Agreement dialog box.

7. Read the license agreement. If you agree, click Yes to open the Choose 
Destination Location dialog box.

8. The default destination folder is C:\ispTOOLS7_1. Click Browse to 
change the drive or destination folder.

Figure 2: Product to Install Dialog Box
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Installing ispLEVER Tools Installing ispLEVER 7.1 Software for Windows
9. Click Next to open the Product Options dialog box, shown in Figure 3.

10. Select the ispLEVER components that you want to install by selecting or 
clearing each of the listed options. If you have purchased third-party 
synthesis and simulation tools directly from the third-party vendors, you 
can clear these product options.

Figure 3: Product Options Dialog Box

Click for additional options
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Installing ispLEVER 7.1 Software for Windows Installing ispLEVER Tools
Some of the product options have additional options of their own, as 
shown in Table 5. To set the additional options, select a product option 
and click Change.

11. Click Next to open the Select Program Folder dialog box. The default 
name of the program group is Lattice Semiconductor. If you want to 
change the name, change it in the Program Folder text box.

12. Click Next to open the Start Copying Files dialog box.

13. Verify the settings when displayed.

14. Click Next to start installing the ispLEVER components. If you are using 
the CD-ROMs, the installer will prompt you to swap disks during the 
installation.

15. If you have selected the ispVM System option, you will be prompted to 
install drivers for using the ispDOWNLOAD® cable. Click Yes, and follow 
the instructions in “Installing Parallel Port Driver and USB Driver” on 
page 12.

16. The Active Support dialog box appears toward the end of the installation. 
It requests your permission to allow Lattice Semiconductor to collect 
limited design information for product development purposes. 

Click either I Accept or I Decline. 

In either case, installation will finish normally so that you can use the 
software. 

Table 5: Product Options

When you select: Click Change to also select:

ispLEVER software Use CHECKSUM as USERCODE default: Sets the default for USERCODE to 
CHECKSUM. With this option, the ispLEVER software inserts the JEDEC file's 
CHECKSUM value into the USERCODE field. If the ispLEVER software is generating 
an ISC data file, it inserts the CRC value into the USERCODE field.

Note: For LatticeXP, LatticeXP2, and MachXO devices, CHECKSUM is the default 
for USERCODE.

SVF Generation: Installs the ispVM System and sets the default for SVF generation.

FPGAs Specific Lattice Semiconductor FPGA devices. You can install software for some or 
all of the Lattice FPGA devices: LatticeECP2/LatticeECP2S, LatticeECP2M/
LatticeECP2MS, LatticeSC/LatticeSCM, LatitceXP2, MachXO, LatticeXP, LatticeEC/
LatticeECP
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Installing ispLEVER Tools Installing ispLEVER 7.1 Software for Windows
If you finish the installation and want to change your decision, choose 
Start > All Programs > Lattice Semiconductor 7.1 > Accessories > 
Active Support, then click I Accept or I Decline.

17. If you have selected the Active-HDL Lattice Edition option, you will be 
prompted to select a license option. Follow the instructions in “Selecting a 
License Option for Active-HDL” on page 13.

18. In the dialog box that follows, verify the environment variables. Click Next.

19. In the InstallShield Wizard Complete dialog box, click Finish.

20. Wait for the original ispLEVER Setup window to be active again. In the 
ispLEVER Setup window, you can install other software, register and 
license the ispLEVER software, or exit the setup program. If you install the 
ispVM System driver, the system will prompt you to restart your computer. 

21. After exiting the setup program, remove the CD-ROM or DVD-ROM from 
the drive.

Note

Do not close the installation window. The window will be automatically closed 
when the installation completes.
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Installing Parallel Port Driver and USB Driver
A parallel port or a USB driver is required to program Lattice devices using the 
ispDOWNLOAD Cables and the ispVM System software. You can install 
either or both of these drivers.

To install the parallel port driver, USB driver, or both:

1. In the LSC Drivers Install/Uninstall dialog box, select one driver or Both 
Drivers to be installed, as shown in Figure 4.

2. If you selected LSC WinNT/2000/XP/Vista Parallel Port Driver or Both 
Drivers in step 1, select the desired parallel port driver under Parallel Port 
Driver Installation Options:

Driver’s service starts on demand only (Default) – This driver allows 
PCs and laptops to enter system standby mode when ispVM System 
is not running. This mode reduces the power consumption of your PC 
or laptop.

Driver’s service starts during startup of the system (Backwards 
Compatible) – This driver is backward-compatible with previous 
versions of ispVM System and ispDCD. However, it might prevent 
some PCs and laptops from entering system standby mode.

Note

For more information on ispDOWNLOAD Cables, see http://
www.latticesemi.com/products/developmenthardware/
programmingcables.cfm.

Figure 4: LSC Drivers Install/Uninstall Dialog Box
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Installing ispLEVER Tools Installing ispLEVER 7.1 Software for Windows
3. If another driver is already installed, you can click Uninstall if you want to 
remove it. 

4. Click Install.

5. Click OK, and follow the installation instructions on the screen.

At the end of the installation, you must reboot your PC to load the driver.

Selecting a License Option for Active-HDL
If you have selected the Active-HDL Lattice Edition option when installing 
ispLEVER, a dialog box will appear at the end of the installation, prompting 
you to select a license option for running Active-HDL.

To select a license option for Active-HDL:

In the Active-HDL Lattice Edition Selection dialog box, select either Node-
Lock License or Floating License via USB key, as shown in Figure 5.

Note

If you skip the LSC Driver Install process during installation, you can always install the 
drivers later from the ispVM System menu command.

Figure 5: Active-HDL Lattice Edition Selection Dialog Box
ispLEVER 7.1 Installation Notice 13



Installing ispLEVER 7.1 Software for Windows Installing ispLEVER Tools
If you select Floating License via USB key, the system will start 
installing the driver for the Aldec dongle. When prompted “The operation 
was completed successfully,” click OK.

You can also install the Aldec dongle driver separately. See “Aldec Dongle 
Driver Installation” on page 24 for more information.

Adding ispLeverDSP Paths to Matlab Search 
Path List
If you have installed Matlab/Simulink, the ispLEVER installation will 
automatically update the Matlab search path list to include the paths listed 
below. This enables you to use ispLeverDSP blockset in Matlab/Simulink.

<isplever_install_path>\ispLeverDSP
<isplever_install_path>\ispfpga\bin\nt

In case the automatic update fails, you can always use either of the following 
methods to add the paths manually.

To add ispLeverDSP paths using the “Set Path” menu command:

1. Start the Matlab software.

2. In Matlab desktop, choose File > Set Path.

3. In the Set Path dialog box, click Add Folder, browse to 
<isplever_install_path>\ispLeverDSP, and click OK.

4. Repeat Step 3 to add the <isplever_install_path>\ispfpga\bin\nt path.

5. Click Save to apply the settings, and then click OK.

To add ispLeverDSP paths from the command line:

To add ispLeverDSP paths to the Matlab search path list, execute the 
sub_mpath program in the 
<matlab_install_path>\help\toolbox\ispleverdsp directory. The syntax is:

cd <matlab_install_path>\help\toolbox\ispleverdsp
sub_mpath –add <isplever_install_path>\ispLeverDSP –add 
<isplever_install_path>\ispfpga\bin\nt

Note

To skip the license selection in this dialog box, select Node-Lock License and 
click Next. The Cancel button cancels the entire ispLEVER installation.
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Troubleshooting
If you encounter any software-related problems after installing the ispLEVER 
software, review the following common troubleshooting scenarios before 
calling Lattice Semiconductor Technical Support:

Ensure that your environment variable settings are set correctly, including 
the TEMP user variable. Your Windows XP, Windows 2000, or 32-bit 
Windows Vista system should contain the following system environment 
settings:

SET LSC_INI_PATH=<boot_drive>:\LSC_ENV
SET LM_LICENSE_FILE=<install_path>\license\license.dat

You can verify these settings by choosing Start > Settings > Control 
Panel > System. Select the Advanced tab and the “Environment 
Variables” section.

Make sure that your system video display is set to a screen resolution of 
1024 x 768 or more and that your video display is set to use 256 or more 
screen colors.

If the ispLEVER software is installed on a Windows XP or 32-bit Windows 
Vista system with administrator privilege and is to be used by an account 
in the “Users” group, make sure that the user account has permission to 
write the following folder and the configuration file in that folder:

<boot_drive>:\LSC_ENV 
<boot_drive>:\LSC_ENV\lsc_7_1.ini

If you have trouble viewing the ispLEVER Help using your default 
browser, check the browser’s options to make sure that JavaScript is 
enabled. If you are using Internet Explorer with the Windows XP operating 
system, a security feature that blocks active resident HTML files on your 
computer might issue a warning message when you try to open the 
ispLEVER Help. The message warns that these files can be useful but 
dangerous. You can safely ignore this warning. Follow the Internet 
Explorer's instructions to view the Help.

Note

The LM_LICENSE_FILE variable is a single line entry.
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Licensing for the ispLEVER Software
At the end of the installation, you will use either the online registration form 
included in the installation setup program or the Web-based registration 
capability to register and license your ispLEVER software. To use the 
software, you must receive a permanent Lattice Semiconductor software 
license based on the identification of your network interface card (NIC) or 
alternate network interface, such as a wireless interface. The NIC ID or 
equivalent is the 12-character hexadecimal physical address. License your 
software early to avoid any down time.

The ispLEVER license requires your machine to be connected to the network 
or Internet. If your machine is not connected to the network, the license 
checkout process might fail when you try to start ispLEVER, even though you 
have a valid license for ispLEVER.

In the absence of a network connection, you can install the NWLink IPX/SPX 
protocol to force the recognition of your NIC card ID. 

To install the NWLink IPX/SPX protocol:

1. Right-click My Network Places on the desktop and select Properties.

A list of all the networks available opens.

2. Right-click Local Area Network and select Properties. 

3. In the Local Area Connection Properties dialog box that appears, perform 
the following steps:

a. Click Install.

b. Select Protocol and click Add.

c. Select NWLink IPX/SPX.

d. Click OK and follow the instructions on the screen.

4. If needed, reboot your machine.

Licensing ispLEVER Through the Web Site
The quickest way to license your ispLEVER software is to use the Licensing 
form on the Lattice Semiconductor Web site.

To license ispLEVER through the Lattice Semiconductor Web site:

1. After installation is complete, click Registration and License in the 
ispLEVER Setup window. Or choose Start > Programs > Lattice 
Semiconductor > ispLEVER Registration and License Request. 
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The registration form appears.

2. Note the Network Interface Card ID and the hard disk ID in the form.

3. Go to the Licensing section of the Lattice Semiconductor Web site. 
(www.latticesemi.com/license).

4. On the Software Licensing page, under ispLEVER, click Request a new 
license or Request a floating license to request a node-locked, single 
user license, or a floating license. Then follow the on-screen instructions.

You will receive your Lattice Semiconductor license file (license.dat) by e-
mail.

5. Copy the license file (license.dat) to the ispLEVER software license 
directory, as shown here:

<install_path>\license\license.dat

Licensing ispLEVER by E-mail or Fax
You can license and register the ispLEVER software by sending your 
completed registration and license request by e-mail or fax.

To license the ispLEVER software by e-mail or fax:

1. After installation is complete, click Registration and License in the 
ispLEVER Setup window. Or, exit the Setup program and choose Start > 
Programs > Lattice Semiconductor > ispLEVER Registration and 
License Request. 

The registration form appears.

2. Fill in the registration form completely. Your NIC ID is automatically 
scanned and displayed in the Network Interface Card ID field. The product 
serial number can be found on the Save This Serial Number card. You can 
choose to request a node-locked, single user license, or a floating license.

3. Click OK. 

Your registration information is saved automatically as a text file 
(pdspsreg.txt) in the default ispTOOLS7_1\prod_reg folder.

Note

The license directory contains a file named license.txt, which is the Lattice 
Semiconductor license agreement. Do not rename your license.dat file to 
license.txt or in any way replace license.txt with another file.

For information on floating license setup, see “Optional Floating License Setup” on 
page 18.
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4. E-mail the completed registration file to lic_admn@latticesemi.com, or 
print the registration file and fax it to (503) 268-8556. The registration file 
must include your NIC ID. 

Lattice Semiconductor will send your ispLEVER software license file by e-
mail or fax within one working day.

5. Copy the license file (license.dat) to the ispLEVER software license 
directory, as shown here:

<install_path>\license\license.dat

Finding the Installation History
When you install a service pack or control pack, the ispLEVER software 
records a log of the installation history, which you can find in the Project 
Navigator. 

To view the installation history:

1. Open the Project Navigator.

2. Select Help > About Project Navigator.

Optional Floating License Setup
To enable a floating license, you must have a license server set up on a 
Windows NT server to monitor your ispLEVER software license. Each client 
PC must have the LM_LICENSE_FILE variable set to point to the license file 
on the server.

Before you start the server setup, ensure that TCP/IP is installed and that the 
client machines can communicate with the server by name. At the prompt in 
an MS-DOS window, type the following: 

ping <hostname>

Note

The license directory contains a file named license.txt, which is the Lattice 
Semiconductor license agreement. Do not rename your license.dat to license.txt or 
in any way replace license.txt with another file.

For information on floating license setup, see “Optional Floating License Setup” on 
page 18.
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Table 6 lists the files used for license management.

Table 6: License Management Files

Filename Location Description

LMGRD.exe <install_path>\ispcpld\bin The license server program

LMUTIL.exe <install_path>\ispcpld\bin FLEXlm utility for diagnosing, reporting, and controlling 
licensing

LMTOOLS.exe <install_path>\ispcpld\bin Program that sets up the server for floating licenses

ispdsdmn.exe <install_path>\ispcpld\bin The Lattice Semiconductor licensing daemon

Note

The ispLEVER 7.1 software uses FLEXlm 11.4 license administration software. Users 
of the ispLEVER 3.1 or older software must bring down the previous license daemon 
and start the new license daemon.
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Editing the License File
After obtaining a floating license from Lattice Semiconductor, you must edit 
the license file to specify the server name and the paths to the Lattice 
daemon. An example of a floating license file is shown in Figure 6.

Figure 6: Sample Floating License File

SERVER nodename 00609779b32b 7788

DAEMON lattice daemon_path

FEATURE LSC_ADVANCED lattice 8.0 01-jan-9999 1 78CF32A89262 \
VENDOR_STRING="ispLEVER Advanced"
FEATURE LSC_ADVANCED_DSP lattice 10.0 01-jan-9999 1 
354CE2384BA4 \
VENDOR_STRING="ispLEVER DSP"
FEATURE LSC_ADVANCED_ORCA lattice 9.0 01-jan-9999 1 
CDC69F53494F \
VENDOR_STRING="ispORCA System"
FEATURE LSC_ADVANCED_ORLI10G lattice 9.0 01-jan-9999 1 
E961B68558D8 \
VENDOR_STRING="ORLI10G FPSC Design Kit"
FEATURE LSC_ADVANCED_ORSO42G5 lattice 9.0 01-jan-9999 1 
7D6997657210 \
VENDOR_STRING="ORSO42G5 FPSC Design Kit"
FEATURE LSC_ADVANCED_ORSO82G5 lattice 9.0 01-jan-9999 1 
55ADAB4D2EBC \
VENDOR_STRING="ORSO82G5 FPSC Design Kit"
FEATURE LSC_ADVANCED_ORT8850 lattice 9.0 01-jan-9999 1 
979DD6A73EB6 \
VENDOR_STRING="ORT8850 FPSC Design Kit"
FEATURE LSC_ADVANCED_PLUS lattice 8.0 01-jan-9999 1 
7189753BE7DC \
VENDOR_STRING="ispLEVER Advanced Plus"
FEATURE LSC_CLASSIC lattice 10.0 01-jan-9999 1 F4A166F5097A \
VENDOR_STRING=LSC_CLASSIC
FEATURE LSC_SYNPLIFY lattice 8.0 01-jan-9999 1 68ED4797009A \
VENDOR_STRING="ispLEVER System with Synplicity"
FEATURE LSC_WARRANTY lattice 10.0 09-may-2008 1 38054C63F04E \
VENDOR_STRING=LSC_WARRANTY

Note

The “\” followed by a carriage return indicates a line continuation.
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To edit the license file:

1. Edit the SERVER line by replacing nodename with the host name of the 
server for which you requested your license.dat file. You may also need to 
change the PORT NUMBER (7788).

2. Edit the DAEMON lattice line by replacing daemon_path with the path 
to the lattice daemon, for example:

C:\ispTOOLS7_1\ispcpld\bin\ispdsdmn.exe

3. When you are editing these lines, make sure that they are typed exactly 
as you received them.

License Server Setup
To set up your license manager as a system service:

1. Copy the license file (license.dat) to <install_path>\license\license.dat.

2. Double-click the <install_path>\ispcpld\bin\lmtools.exe file to open the 
LMTOOLS dialog box.

3. Choose the Config Services tab in the LMTOOLS dialog box.

4. Change Service Name to Lattice FLEXlm Service 1.

5. Browse and set lmgrd.exe to <install_path>\ispcpld\bin\lmgrd.exe.

6. Browse and set the license file to <install_path>\license\license.dat.

7. Browse and set the debug log file to <install_path>\license\lattice.log.

8. Click Save Service.

9. Select the Start/Stop/Reread tab.

10. Click Start Server.

11. Select the Config Services tab.

12. Select View Log to view the lattice.log file. Check to see if there are any 
problems starting the license server. If there are no problems, close the 
log file.

13. Choose Start > Programs > Lattice Semiconductor > ispLEVER 
Project Navigator to verify license checkout (this will be reflected in the 
lattice.log file). Close ispLEVER.

14. Choose the Start/Stop/Reread tab in the LMTOOLS dialog box.

15. Select Stop Server.

16. Select the Config Services tab. Select Use Services and Start Server at 
Power-Up.
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17. Click Save Service, and then select File > Exit.

18. Restart the Windows server system.

19. Start the ispLEVER software again to verify that the license server is 
running as a service.

Floating License Configuration
In this configuration, the ispLEVER software is installed on your Windows 
license server (for license manager utilities and daemons) and on each client 
that uses the ispLEVER software. This configuration gives the best run-time 
performance.

Install the ispLEVER software on the license server first. After you receive 
your floating license and ensure that the license manager is running, install 
the ispLEVER software locally on each client that will use the floating license.

Set your system variable LM_LICENSE_FILE to point to the 
<install_path>\license\license.dat file on the license server.

Troubleshooting
If you encounter problems with your license, refer to Table 7 for common 
FLEXlm error messages and possible causes or solutions.

Table 7: FLEXlm Error Messages

FLEXlm Error Message Possible Causes or Solutions

Invalid parameter [-42, 252] The LM_LICENSE_FILE variable has not been set properly.

The license file is invalid.

An invalid feature is specified in the license file.

Invalid parameter [-42, 252:10061]
Winsock error code

You have a floating license, and the license daemon has not 
been started at the Windows NT server.

The network connection between the server and the client 
has not been established.

Invalid parameter [-12, 122]
Invalid returned data from license server

The node name of the Windows NT server does not match the 
one in your floating license file.
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If you encounter any software-related problems, review the following common 
troubleshooting scenarios before calling Lattice Semiconductor Technical 
Support:

Ensure that your environment variable settings are set correctly, including 
the TEMP user variable. For Windows XP, Windows 2000, and 32-bit 
Windows Vista, your system should contain the following environment 
settings:

SET LSC_INI_PATH=<boot_drive>:\LSC_ENV
SET LM_LICENSE_FILE=<install_path>\license\license.dat

You can verify these settings by choosing Start > Settings > Control 
Panel > System. Select the Advanced tab and the Environment 
Variables section.

Make sure that your system video display is set to a screen resolution of 
1024 x 768 or more and that your video display is set to use 256 or more 
screen colors.

If the ispLEVER software still does not run after you have installed your new 
license file and confirmed that your environment variables are correct, gather 
the following items:

A screen capture showing the error message

A text file that contains a listing of the environment setup for your PC. 
From an MS-DOS prompt window, issue the set > env.txt command.

Your license.dat file

Combine these items in a zip file and e-mail it to 
techsupport@latticesemi.com. Include an explanation of the problem.

Invalid parameter [-5, 222]
No such feature exists

The feature could not be found in the license file.

! License Check Failed You either have a node-locked license or you do not have a 
license file. Contact Lattice Semiconductor Technical Support for 
a valid floating license file.

Table 7: FLEXlm Error Messages

FLEXlm Error Message Possible Causes or Solutions
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Aldec Dongle Driver Installation
During ispLEVER installation, you can select Floating License via USB Key 
to install the Aldec dongle driver, as shown in “Selecting a License Option for 
Active-HDL” on page 13. However, you can also install the Aldec dongle 
driver separately. For more information on the separate installation, refer to 
<isplever_install_path>\active-hdl\Drivers\install.txt. The drivers and 
additional information are located at <isplever_install_path>\active-
hdl\Drivers\HASP.

Installing ispLEVER PRO
The ispLEVER PRO is a separate product that includes both ispLEVER and a 
suite of intellectual property cores. The following installation instructions apply 
only to users of the ispLEVER PRO software.

To install ispLEVER PRO, first install the ispLEVER software using the 
instructions in the “Installation Procedure” on page 6. Afterwards, install the 
following IP cores from the ispLEVER PRO IP Value Suite CD:

DDR SDRAM Controller – Pipelined

DDR2 SDRAM Controller – Pipelined

FFT Compiler

FIR Filter Generator

Tri-Speed Ethernet MAC

The devices supported for each of the ispLEVER PRO IP cores are shown in 
Table 8

Table 8: IP Cores Installed by ispLEVER PRO 

IP Name LatticeSC/M LatticeECP2/M LatticeECP/EC LatticeXP LatticeXP2

DDR SDRAM Controller – 
Pipelined

DDR2 SDRAM Controller – 
Pipelined

FFT Compiler
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All other supported IP cores are available from the ispLEVER IP Installation 
CD that is included with ispLEVER 7.1. They are also available for installation 
using the IP Express tool. See “Updating IP Files with IPexpress” on page 26.

You must close the Project Navigator before installing the ispLEVER PRO IP.

To install the ispLEVER PRO IP from the CD:

1. Insert the ispLEVER PRO IP Value Suite CD into the drive.

The ispLeverCORE IP Setup window automatically appears.

You can also run <CD-ROM drive>:\setup.exe to start the installation 
program manually.

2. Click Next to open the License Agreement window. 

3. Read the License Agreement. If you agree with the terms, click Yes to 
open the Choose Destination Location window. 

4. The default destination folder is C:\ispLEVERCore. Click Browse to 
change the drive or destination folder.

5. Click Next to open the Product Options window. 

6. Select the IP cores that you want to install by selecting or clearing each 
one on the list.

7. Click Next to begin the installation.

After they are installed, the IP cores are accessible from IPexpress.

Licensing ispLEVER PRO
The ispLEVER PRO requires a license from Lattice Semiconductor. The 
license is good for one year and can be renewed through an annual 
subscription.

To license the ispLEVER PRO, both the software and IP, follow the 
instructions in the “Licensing for the ispLEVER Software” on page 16. 

FIR Filter Generator

Triple Speed Ethernet MAC

Table 8: IP Cores Installed by ispLEVER PRO  (Continued)

IP Name LatticeSC/M LatticeECP2/M LatticeECP/EC LatticeXP LatticeXP2
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Updating IP Files with IPexpress
You can always check for updates to Lattice IP cores using the IPexpress 
tool. You can then use IPexpress to download the latest IP files from the 
Lattice web site.

To download updated IP files using IPexpress:

1. In the Main Window of IPexpress, click the IP Server tab, located at the 
lower left portion of the window.

2. Expand the Lattice IPs Server tree in the left pane. IPexpress connects to 
the Lattice web site.

3. Highlight the IP that you want to download. If you want to view information 
on the IP before downloading, right-click and choose View <IP_name> 
Document from the pop-up menu.

4. Right-click the IP and choose Download <IP_name> from the pop-up 
menu, or click the Download IP button from the toolbar.

5. In the Save dialog box, specify the location where you want the IP to 
reside on your computer.

6. Click Save. 

The selected IP is downloaded to your computer.

Installing ispLEVER IP
All Lattice IP cores are available for evaluation from the ispLEVER IP 
Installation CD included with the ispLEVER 7.1 shipment. There are two 
methods for installing the Lattice IP cores: 

You can install new IP cores directly using the IPexpress tool included 
with ispLEVER. See “Updating IP Files with IPexpress” on page 26 for 
detailed instructions.

You can install the Lattice IP cores using the ispLEVER IP Installation CD 
that is included with the ispLEVER 7.1 shipment.

For detailed descriptions of the Lattice IP cores, visit the Intellectual Property 
section of the Lattice website.

Note

The ispLEVER IP Installation CD is included only in the Windows version.
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You must close the Project Navigator before installing the IP cores.

To install the Lattice IP from the CD:

1. Insert the ispLEVER IP Installation CD into the drive.

The ispLeverCORE IP Setup window automatically appears.

You can also run <CD-ROM drive>:\setup.exe to start the installation 
program manually.

2. Read the License Agreement. If you agree with the terms, click Yes to 
open the Choose Destination Location window. 

3. The default destination folder is C:\ispLEVERCore. Click Browse to 
change the drive or destination folder.

4. Click Next to open the Product Options window.

5. Select from the IP Suites listed by selecting or clearing each one on the 
list. To select individual IP cores within the suite, click the Change button, 
and then select the IP you want to install.

6. Click Next to begin the installation.

After they are installed, the IP cores are accessible from IPexpress.

Running Multiple Versions
The ispLEVER software enables you to run FPGA designs on platforms on 
which 7.1 and previous versions are installed.

For versions of ispLEVER software before 3.0, the %FOUNDRY% and 
%FPSC% environment variables must be defined specifically for that release, 
and %PATH% must contain an entry pointing to %FOUNDRY%/bin/nt. These 
variables, which were set up automatically by the previous release's installer, 
must not be removed if you wish to continue using the older ispLEVER 
release.

Versions 3.0 and newer of the FPGA tools no longer require these variables 
and are not affected by installations of previous versions of ispLEVER 
software.

Note

Clear the Value Suite selection if you have already installed the ispLEVER PRO IP.
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If you want to use command-line versions of the FPGA tools, you can do the 
following:

Run them in the ispLEVER console window as is.

Include in PATH an entry pointing to the following directory, and then run 
the program in a window outside of the Project Navigator:

<installation_directory>\ispfpga\bin\nt

Removing Old ispLeverDSP Blocksets
If you have multiple versions of ispLEVER software installed, you will have 
multiple versions of ispLeverDSP blocksets. The ispLeverDSP installer does 
not remove the paths of old ispLeverDSP versions from the MATLAB/
Simulink software, so old blocksets might be used instead of the new 
blocksets. Follow these steps to manually remove paths of old ispLeverDSP 
from MATLAB/Simulink:

1. In MATLAB desktop, choose File > Set Path.

The Set Path dialog box appears.

2. In MATLAB search path list, remove old ispLeverDSP paths. Save and 
close the dialog box.

Running ispLEVER from a Remote Client
You can install the ispLEVER software on a server and then set up a remote 
client to run the software across your network. A remote client setup program, 
remotecl.exe, can properly set up and prepare the client to run the ispLEVER 
software remotely. This feature works for any number of users, all ispLEVER 
software tools, and all supported devices.

Before You Start
Before you start installation, be aware of the following items:

Microsoft Windows 2000, Windows XP, or 32-bit Windows Vista must be 
running on both PCs.

Administrator privilege is required to install software and to share folders.

Before installation, you should have all requested information. You will 
need to supply the following items:

Your name 

Company name
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Address, city, state, zip/postal code, country

Phone number and fax number

Platform (Windows XP Professional, Windows 2000 Professional SP2 
or later, or 32-bit Windows Vista)

Software serial number (for multi-seat licenses, include all serial 
numbers)

Installation Procedure
To start the installation and run ispLEVER remotely, follow the procedures in 
this section.

To install ispLEVER software on the server:

1. On the server, install the ispLEVER 7.1 software in the designated 
folder—for example, C:\LATTICE_SW\ISPTOOLS7_1. Specify a proper 
program group, such as “ispTOOLS Server.”

2. Make sure that the ispLEVER software on the server runs correctly. 

3. Share the installation folder on the network—for example, 
C:\LATTICE_SW\ISPTOOLS7_1.

To set up the remote client to run ispLEVER remotely:

1. Map the shared network folder on the server to a local drive on the client, 
as in this example: 

map \\<server_name>\LATTICE_SW to drive M:

2. Go to ispLEVER on the new drive at M:\ispTOOLS7_1 and double-click 
the remotecl.exe remote client setup program. This program installs 
examples and sets environment variables on the client machine.

3. Specify the location of the server software—for example, 
M:\ispTOOLS7_1. The client setup program will issue an error message if 
it does not find a key program in the specified location.

4. The remote client setup prompts you for the location on the client machine 
for installing the client files. Specify a proper location—for example, 
C:\isptools7_1_client. Make sure that no blank spaces are used in the 
program path.

5. Specify a proper program group, such as “ispTOOLS Client.”

6. When the remote client installation is finished, set the LM_LICENSE_FILE 
environment variable to be the location of your license file. When you use 
a client-server setup, it is recommended that you use a floating license. 
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Then set LM_LICENSE_FILE=7788@nodename. Confirm that it works by 
selecting and compiling one of the examples now on the client.

Minimal Installation Option
The remote client setup program, remotecl.exe, also allows the following 
command-line options:

remotecl.exe -v min:dir:<installed_directory path>

Here is an example:

remotecl.exe -v min:dir:m:\isptools

where m: is the server drive that contains the installed ispLEVER.

This command sets up the client remote system to have the minimum 
configuration for the ispLEVER software. 

1. Create DEXP7_1.ini in the remote client Windows directory, and update 
the information and directory paths.

2. Create the LSC_INI_PATH environment variable in the remote client 
system. Set this variable to C:\lsc_env.

3. Create lsc_7_1.ini in the remote client directory defined by the 
LSC_INI_PATH environment variable and update the information and 
directory paths in this .ini file.

After this option is specified, the remote installation will not display any GUI 
dialog boxes and will run the installation in batch mode.

Installing PAC-Designer Software
In addition to the ispLEVER software, you have the option of installing the 
PAC-Designer software. The software includes all the tools you need for 
designing and downloading Lattice Semiconductor's ispPAC devices.

To install PAC-Designer on your PC:

1. Run the setup.exe file as you would for ispLEVER installation.

2. In the Lattice Semiconductor ispLEVER Setup window, click Install PAC-
Designer. A setup wizard guides you through the installation.
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3. Obtain a valid license from the Lattice Semiconductor Web site 
(www.latticesemi.com/license). Follow the instructions on the licensing 
page of the Web site to obtain a valid license.dat file.

4. Restart your computer before running the PAC-Designer software.

5. Configure the JTAG (programming) interface. The ispPAC family uses a 
JTAG serial interface for programming, uploading, and verification. Set up 
PAC-Designer with the port address through the JTAG Options dialog 
box.

Installing Adobe Acrobat Reader
Many of the documents in the Lattice Semiconductor ispLEVER 
documentation set require the Adobe Acrobat Reader for viewing and 
printing. If you do not have Acrobat Reader, version 6.0 or later, it is 
recommended that you install it to ensure proper viewing and printing of the 
documents.

To install Acrobat Reader 6.0 on your PC:

1. Run the setup.exe as you would for ispLEVER installation.

2. In the Lattice Semiconductor ispLEVER Setup window, click Install 
Adobe Reader 6.0.

3. In the Acrobat Reader 6.0 Setup window, click Next. You can click 
Cancel to exit the setup in the Exit Setup dialog box.

4. In the Software License Agreement window, click Accept.

5. In the Choose Destination Location dialog box, either accept the default 
folder location or use the Browse button to install in the folder of your 
choice.

6. Click Next. 

Acrobat Reader is installed in the location that you specified.

7. Click Finish to exit the wizard.

With Acrobat Reader installed, you can open PDF documents by browsing 
through the following ispLEVER documentation directories:

<install_path>\ispcpld\manuals\

<install_path>\ispcpld\Tutorial\
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Updating the ispLEVER Software
After you have registered and licensed your installation, check the Lattice 
Semiconductor Web site for new software updates, device support, and 
enhancements. Make sure that you have the latest software by checking for 
updates regularly.

To activate ispUPDATE:

1. Choose Start > Programs > Lattice Semiconductor > ispUPDATE. 

The main ispUPDATE window appears, as shown in Figure 7.

2. In the main window, click Setting.

The Internet Connection Setting dialog box now appears, as shown in 
Figure 8.

Figure 7: ispUPDATE Window
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Changing the Connection Settings
To enable automatic checking, you must indicate how your computer 
accesses the Internet.

To change the Internet connection settings:

1. Select the Connections tab of the Internet Connection Setting dialog box, 
shown in Figure 8.

2. Select one of the three Internet settings provided:

Connect to the Internet directly 

Select this option if you do not have to go through a proxy server.

Use a proxy server 

Select this option if you must go through a proxy server before 
connecting to the Internet. The proxy server prevents outsiders from 
breaking into your organization’s private network. Ask your system 
administrator for the URL address and port assignment. This option is 
turned on by default.

Use automatic proxy configuration script

Select this option if you have an automatic proxy configuration file. 
Ask your system administrator for the URL address and type it in the 
text box provided.

Figure 8: Connections Tab
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Changing the Automatic Checking Settings
The Lattice Semiconductor software can automatically check for updates and 
activate a window showing the ispLEVER updates that are available. 

If you want to turn off or change the automatic update checking, change the 
settings in ispUPDATE as follows:

1. Select the Auto Check tab of the Internet Connection Setting dialog box.

2. If you want to enable the automatic checking for software updates, make 
sure that the Automatic check for ispLEVER software update option is 
turned on. It is turned on by default. 

If you want to disable the automatic checking, turn off the Automatic 
check for ispLEVER software update option, as shown in Figure 9.

3. If you turned on the Automatic check for ispLEVER software update 
option, indicate the frequency with which you want the checking to be 
performed: every time that the Project Navigator is started, daily, or 
weekly. A daily check is the default.

4. Select Enable log to keep a record of the ispLEVER update checking. 
When you select this option, a log is kept even if automatic checking is not 
implemented. This option is selected by default.

If desired, rename the log file and select a different directory for the 
log file.

Figure 9: Disabling Automatic Checking in Auto Check Tab
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Select Overwrite log to save only the last log. This option is selected 
by default. Clear this selection to append each log to the previous one.

5. Click OK.

Installing a Recommended Service Pack
When you use the Auto Check feature, ispUPDATE notifies you whenever a 
new service pack becomes available. You receive notification when you open 
the Project Navigator.

To install the recommended service pack:

Do one of the following:

Click Upgrade Now to immediately install the service pack.

Click Download to save the service pack to a directory and install it later.

Click Upgrade Later to do nothing now. You can wait for the next 
automatic check or update manually at a convenient time.

To manually check for and install a service pack:

1. Close all ispLEVER tools.

2. Choose Start > Programs > Lattice Semiconductor > ispUPDATE.

3. In the dialog box, click Update.

The ispUPDATE software goes online to check for service packs. If one is 
available, the Select ispLEVER Pack Version dialog box opens.

4. In the top portion of the dialog box, choose the desired installed version of 
ispLEVER and a service pack.

5. Click Update.

To install a downloaded service pack:

1. Close all ispLEVER tools.

2. Go to the location where you saved the service pack.

3. Double-click the service pack file and follow the on-screen instructions.
ispLEVER 7.1 Installation Notice 35



When All Else Fails Installing ispLEVER Tools
When All Else Fails
If the ispLEVER software still does not run after you have installed your new 
license file and confirmed that your environment variables are correct, gather 
the following items:

A screen capture showing the error message

A text file that contains a listing of the environment setup for your PC. 
From an MS-DOS Prompt window, issue the set > env.txt command.

Your license.dat file 

Put these items into a zip file and e-mail it to techsupport@latticesemi.com, 
including an explanation of the problem.
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Installing LatticeMico32 
Development Tools
This chapter explains how to install the LatticeMico32 Development Tools.

You can install the LatticeMico32 Development Tools as a part of the 
ispLEVER software or as stand-alone software if ispLEVER is not installed.

If the 7.1 version of ispLEVER is installed on your computer, the 
LatticeMico32 Development Tools will be installed by default in a folder 
called micosystem, which resides in the folder in which ispLEVER was 
installed. For example, the LatticeMico32 Development Tools could be 
installed in the <install_drive>:\ispTOOLS7_1\micosystem directory.

If the 7.1 version of ispLEVER is not installed on your computer, the 
LatticeMico32 Development Tools will be installed by default in a folder 
called micosystem, which resides in the LatticeMico32 folder. For 
example, the LatticeMico32 Development Tools could be installed in the 
<install_drive>:\LatticeMico32\micosystem directory.

During installation, you are prompted to select the installation path for the 
LatticeMico32 Development Tools.
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Installing LatticeMico32 with ispLEVER
To take advantage of the full features and functionality of the LatticeMico32 
Development Tools, Lattice Semiconductor recommends that you install the 
7.1 version of ispLEVER before installing the LatticeMico32 Development 
Tools. See “Installing ispLEVER Tools” on page 1 for detailed instructions on 
installing ispLEVER. This section describes how to install the LatticeMico32 
Development Tools on top of the ispLEVER software. These procedures 
assume that you have already installed ispLEVER 7.1. 

If you do not have the current version of ispLEVER installed, you can install 
the LatticeMico32 Development Tools as stand-alone tools. For information 
on this procedure, see “Installing LatticeMico32 as Stand-Alone Software” on 
page 48.

Whether you install LatticeMico32 Development Tools with ispLEVER or as 
stand-alone tools, you can use either of two methods to install them:

You can install them from a CD. 

You can download them from the Lattice Semiconductor Web site at 
http://www.latticesemi.com/mico32.

The following sections describe these two methods.

Installing LatticeMico32 from a CD
Installation of the LatticeMico32 Development Tools starts automatically when 
you insert the CD into the drive. However, if it does not start automatically, you 
can start it manually.

By default, the LatticeMico32 Development Tools are installed in a folder 
called micosystem in the same folder in which you installed ispLEVER.

Installing LatticeMico32 Automatically
This section explains how to install the LatticeMico32 Development Tools 
automatically from the CD.

To install the LatticeMico32 Development Tools automatically from a CD:

1. Insert the LatticeMico32 System CD into the CD-ROM drive.

InstallShield starts automatically. If it does not start, see “Installing 
LatticeMico32 Manually” on page 46 for instructions. 
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The LatticeMico32 Development Tools Setup dialog box automatically 
appears, as shown in Figure 10.

2. Click Next.

3. For full functionality, be sure that both the LatticeMico32 System and the 
GNU-based Compiler Tools options are selected, as shown in Figure 11, 
and then click Next.

Figure 10: LatticeMico32 Development Tools Setup Dialog Box

Note

You can install LatticeMico32 System and the GNU-based Compiler Tools 
separately by checking only one box, but Lattice Semiconductor recommends that 
you accept the defaults and install both tools at the same time.
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When you select the LatticeMico32 System option, the LatticeMico32 
Development Tools do the following:

Install the Eclipse graphical user interfaces, which are components, or 
plug-ins, of the Eclipse development environment on which the 
LatticeMico32 System is based.

Enable Mico System Builder (MSB) to access all ispLEVER 
executables and functions.

Add the LatticeMico32 System icon to the ispLEVER Windows 
Accessories Start folder.

Add the LatticeMico32 System icon to the ispLEVER Project 
Navigator.

Add the LATTICEMICO32SYSTEM environment variable.

If LatticeMico32 System is not installed, you cannot use the LatticeMico32 
System graphical user interface. You can only use the LatticeMico32 
Development Tools through the command line.

Figure 11: Selecting the Product Options
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When you select the GNU-based Compiler Tools option, the 
LatticeMico32 Development Tools do the following:

Install gtools (C++/C tool chain) and cygwin.

Add the LatticeMico32 System SDK shell icon to the ispLEVER 
Windows Accessories Start folder.

Enable the command-line mode for building C/C++ source codes.

Add the LATTICEGNUTOOLS environment variable.

If the GNU-based compiler is not installed, the C++/C and debug 
graphical user interfaces will not function correctly.

4. Click Yes to accept the terms of the licensing agreement for LatticeMico32 
System, shown in Figure 12.

Figure 12: Accepting the License for LatticeMico32 System
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Installing LatticeMico32 with ispLEVER Installing LatticeMico32 Development Tools
5. Click Yes to accept the terms of the licensing agreement for the GNU-
Based Compiler Tools, shown in Figure 13.

The Choose Destination Location part of the LatticeMico32 Development 
Tools Setup dialog box now appears, as shown in Figure 14, so that you 
can choose the folder in which the LatticeMico32 Development Tools will 
be installed. If the current version of ispLEVER is installed, the default 
destination folder will be the same folder in which ispLEVER was installed. 
If the current version of ispLEVER is not installed or you select a 
destination folder other than the default, the installation will be treated as a 
stand-alone installation. The path of the destination folder will then be the 
path of the previous installation of the LatticeMico32 Development Tools 
or the GNU-Based Compiler Tools. If there was no previous installation of 
either, the default destination folder will be the C:\LatticeMico32 folder.

Figure 13: Accepting the License for the GNU-Based Compiler Tools
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Installing LatticeMico32 Development Tools Installing LatticeMico32 with ispLEVER
6. To accept the default destination folder, click Next. Otherwise, click 
Browse to change the drive or destination folder, and then click OK and 
click Next. 

7. In the Select Program Folder part of the dialog box, shown in Figure 15, 
select or type the name of the default program folder, which is the folder 
that contains the Lattice Semiconductor programs that you can choose 

Figure 14: Selecting the Destination Directory
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through the Start menu. If ispLEVER is installed, the default folder is the 
same as that for ispLEVER. Click Next.

Figure 15: Selecting the Program Folder
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8. In the Start Copying Files part of the LatticeMico32 Development Tools 
Setup dialog box, shown in Figure 16, click Next.

Figure 16: Starting the Installation
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Installing LatticeMico32 with ispLEVER Installing LatticeMico32 Development Tools
The installation begins. When it is finished, the LatticeMico32 
Development Tools Installation Completing dialog box appears, as shown 
in Figure 17.

9. Click Finish.

10. Because the installation process added new environment variables, 
reboot your computer.

Installing LatticeMico32 Manually
If the installer fails to start when you insert the CD into the CD-ROM drive, you 
can start it manually.

To install the LatticeMico32 Development Tools manually from a CD:

1. Insert the CD into the CD-ROM drive.

2. Do one of the following:

Double-click setup.exe.

Figure 17: LatticeMico32 Development Tools Installation Completing 
Dialog Box
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Installing LatticeMico32 Development Tools Installing LatticeMico32 with ispLEVER
From the Start menu, choose Run. In the Run dialog box, type or 
select cmd. In the command-line window, type 
disk_drive:\setup.exe, where disk_drive is the name of the CD-ROM 
drive in which you inserted the CD.

InstallShield now starts, and you see the screen shown in Figure 10. To install 
the LatticeMico32 Development Tools when ispLEVER is installed, follow the 
steps given in “Installing LatticeMico32 Automatically” on page 38. To install 
the LatticeMico32 Development Tools as stand-alone software, follow the 
steps given in “Installing LatticeMico32 Automatically” on page 48.

Installing LatticeMico32 from the Web Site
Follow the instructions in this section to install the LatticeMico32 Development 
Tools from the Lattice Semiconductor Web site.

To install the LatticeMico32 Development Tools from the Lattice 
Semiconductor Web site:

1. Go to the LatticeMico32 Web page at the following URL:

http://www.latticesemi.com/mico32

2. Download the LatticeMico32_<version_number>.exe executable.

3. Save the executable in a directory.

4. Double-click the executable to begin the installation.

5. Follow the procedure outlined in “Installing LatticeMico32 Automatically” 
on page 38 after step 1.
ispLEVER 7.1 Installation Notice 47

http://www.latticesemi.com/mico32
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Installing LatticeMico32 as Stand-Alone Software
If you do not have the current version of ispLEVER installed, you can still 
install the LatticeMico32 Development Tools, but their functionality will be 
curtailed. Mico System Builder (MSB) will not be fully functional. You can 
create platforms, but the platform generator will not be fully functional 
because of missing ispLEVER executables and functions. The design-rule 
checker will also not be fully functional. However, the graphical user interfaces 
of the C/C++ Software Project Environment (C/C++ SPE) and the debug 
environment will be fully functional.

Installing LatticeMico32 from a CD
The procedure for installing the LatticeMico32 Development Tools as stand-
alone tools from a CD is similar to the procedure for installing the 
LatticeMico32 Development Tools from a CD on top of ispLEVER, but the 
content of some of the dialog boxes is different. You can start the procedure 
automatically or manually.

By default, the LatticeMico32 Development Tools are installed in the 
C:\LatticeMico32\micosystem folder when you install them as stand-alone 
tools.

Installing LatticeMico32 Automatically
This section explains how to install the LatticeMico32 Development Tools 
automatically from the CD.

To install the LatticeMico32 Development Tools automatically from a CD:

1. Insert the CD into the CD-ROM drive.

InstallShield starts automatically. If it does not start, see “Installing 
LatticeMico32 Manually” on page 46 for instructions. 
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Installing LatticeMico32 Development Tools Installing LatticeMico32 as Stand-Alone Software
The LatticeMico32 Development Tools Setup dialog box automatically 
appears, as shown in Figure 18.

2. Click Next.

3. For full functionality, be sure that both the LatticeMico32 System and the 
GNU-based Compiler Tools options are selected, as shown in Figure 19, 
then click Next.

Figure 18: LatticeMico32 Development Tools Setup Dialog Box

Note

You can install LatticeMico32 System and the GNU-based Compiler Tools 
separately by checking only one box, but Lattice Semiconductor recommends that 
you accept the defaults and install both tools at the same time.
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Installing LatticeMico32 as Stand-Alone Software Installing LatticeMico32 Development Tools
When you select the LatticeMico32 System option, the LatticeMico32 
Development Tools do the following:

Install the Eclipse graphical user interfaces, which are components, or 
plug-ins, of the Eclipse development environment on which the 
LatticeMico32 System is based.

Enable Mico System Builder (MSB) to access all ispLEVER 
executables and functions.

Add the LatticeMico32 System icon to the ispLEVER Windows 
Accessories Start folder.

Add the LatticeMico32 System icon to the ispLEVER Project 
Navigator.

Add the LATTICEMICO32SYSTEM environment variable.

If LatticeMico32 System is not installed, you cannot use the LatticeMico32 
System graphical user interface. You can only use the LatticeMico32 
Development Tools through the command line.

Figure 19: Selecting the Product Options
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Installing LatticeMico32 Development Tools Installing LatticeMico32 as Stand-Alone Software
When you select the GNU-based Compiler Tools option, the 
LatticeMico32 Development Tools do the following:

Install gtools (C++/C tool chain) and cygwin.

Add the LatticeMico32 System SDK shell icon to the ispLEVER 
Windows Accessories Start folder.

Enable the command-line mode for building C/C++ source codes.

Add the LATTICEGNUTOOLS environment variable.

If the GNU-based compiler is not installed, the C++/C and debug 
graphical user interfaces will not function correctly.

The warning shown in Figure 20 now appears.

4. Click OK.

Figure 20: Installation Warning Message Box
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Installing LatticeMico32 as Stand-Alone Software Installing LatticeMico32 Development Tools
5. Click Yes to accept the terms of the licensing agreement for LatticeMico32 
System, shown in Figure 21.

Figure 21: Accepting the License for LatticeMico32 System
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Installing LatticeMico32 Development Tools Installing LatticeMico32 as Stand-Alone Software
6. Click Yes to accept the terms of the licensing agreement for the GNU-
Based Compiler Tools, shown in Figure 22.

The Choose Destination Location part of the LatticeMico32 Development 
Tools Setup dialog box now appears, as shown in Figure 23, so that you 
can choose the folder in which the LatticeMico32 Development Tools will 
be installed. If the current version of ispLEVER is installed, the default 
destination folder will be the same folder in which ispLEVER was installed. 
If the current version of ispLEVER is not installed or you select a 
destination folder other than the default, the installation will be treated as a 
stand-alone installation. The path of the destination folder will then be the 
path of the previous installation of the LatticeMico32 Development Tools 
or the GNU-Based Compiler Tools. If there was no previous installation of 
either, the destination folder will be the C:\LatticeMico32 folder.

Figure 22: Accepting the License for the GNU-Based Compiler Tools
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Installing LatticeMico32 as Stand-Alone Software Installing LatticeMico32 Development Tools
7. To accept the default destination folder, click Next. Otherwise, click 
Browse to change the drive or destination folder, and then click OK and 
click Next. 

8. In the Select Program Folder part of the dialog box, shown in Figure 24, 
select or type the name of the default program folder, which is the folder 
that contains the Lattice Semiconductor programs that you can choose 

Figure 23: Selecting the Destination Directory
54 ispLEVER 7.1 Installation Notice



Installing LatticeMico32 Development Tools Installing LatticeMico32 as Stand-Alone Software
through the Start menu. If ispLEVER is installed, the default folder is the 
same as that for ispLEVER. Click Next.

Figure 24: Selecting the Program Folder
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Installing LatticeMico32 as Stand-Alone Software Installing LatticeMico32 Development Tools
9. In the Start Copying Files part of the LatticeMico32 Development Tools 
Setup dialog box, shown in Figure 25, click Next.

Figure 25: Starting the Installation
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Installing LatticeMico32 Development Tools Installing LatticeMico32 as Stand-Alone Software
The installation begins. When it is finished, the LatticeMico32 
Development Tools Installation Completing dialog box appears, as shown 
in Figure 26.

10. Click Finish.

11. Because the installation process added new environment variables, 
reboot your computer.

Installing LatticeMico32 from the Web Site
Follow the instructions in this section to install the LatticeMico32 Development 
Tools from the Lattice Semiconductor Web site.

To install the LatticeMico32 Development Tools from the Lattice 
Semiconductor Web site:

1. Go to the LatticeMico32 Web page at the following URL: 

http://www.latticesemi.com/mico32 

Figure 26: LatticeMico32 Development Tools Installation Completing 
Dialog Box
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Starting LatticeMico32 Development Tools Installing LatticeMico32 Development Tools
2. Download the LatticeMico32_<version_number>.exe executable.

3. Save the executable in a directory.

4. Double-click the executable to begin the installation.

5. Follow the procedure outlined in “Installing LatticeMico32 Automatically” 
on page 48 after step 1.

Starting LatticeMico32 Development Tools
You can start the LatticeMico32 Development Tools from the ispLEVER 
Project Navigator software, or you can run them as stand-alone tools.

Starting LatticeMico32 Development Tools from 
the ispLEVER Project Navigator
You can use one of three methods to run LatticeMico32 Development Tools 
from the ispLEVER Project Navigator.

To start the LatticeMico32 Development Tools from the ispLEVER Project 
Navigator:

Do one of the following:

In the ispLEVER Project Navigator, choose Tools > LatticeMico32 
System.

In the ispLEVER Project Navigator toolbar, click the  button.

From the Start menu, choose Programs > Lattice Semiconductor > 
Accessories > LatticeMico32 System.

Starting LatticeMico32 Development Tools as 
Stand-Alone Software
When you use the LatticeMico32 Development Tools as stand-alone software, 
you must access them through the Windows Start menu.

To start the LatticeMico32 Development Tools as stand-alone software:

From the Start menu, choose Programs > <program_folder> > 
LatticeMico32 System.
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Configuring Proxy Servers
If you are running the LatticeMico32 Development Tools on a computer that 
has a proxy server, you must set your local area network (LAN) settings to 
use the proxy server to view the LatticeMico32 Help. This section explains 
how to set up a proxy server on computers running a Microsoft Internet 
Explorer browser or a Mozilla Firefox browser.

Setting Up a Proxy Server on Microsoft Internet 
Explorer 
This section gives instructions for setting up a proxy server on computers 
running Microsoft Internet Explorer.

To set up a proxy server on computers running Microsoft Internet Explorer:

1. In Microsoft Internet Explorer, choose Tools > Internet Options to open 
the Internet Options dialog box.

2. Click the Connections tab of the dialog box, shown in Figure 27.

Figure 27: Connections Tab of the Internet Options Dialog Box
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Configuring Proxy Servers Installing LatticeMico32 Development Tools
3. In the Connections dialog box, click LAN Settings to open the Local Area 
Network (LAN) Settings dialog box.

4. In the dialog box, select Use proxy server for your LAN.

5. In the Address box, type the name of the proxy server.

6. In the Port box, type the port number of the proxy server. 

The completed Local Area Network (LAN) Settings dialog box is shown in 
Figure 28. 

7. Click OK in the Local Area Network (LAN) Settings dialog box.

8. Click OK in the Internet Options dialog box.

Setting Up a Proxy Server on Mozilla Firefox
This section gives instructions for setting up a proxy server on computers 
running Mozilla Firefox.

To set up a proxy server on computers running Mozilla Firefox:

1. Open LatticeMico32 System.

2. In MSB, choose Window > Preferences to activate the Preferences 
dialog box.

3. In the Preferences dialog box, do the following:

a. In the left pane, click the plus sign (+) next to General.

b. Click Web Browser.

Figure 28: Local Area Network (LAN) Settings Dialog Box
60 ispLEVER 7.1 Installation Notice
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If Firefox is installed on the PC, the Firefox option should appear in the 
main window of the dialog box.

c. Select Use external Web browser.

d. Select Firefox.

e. Click Apply.

The Preferences dialog box should resemble the example shown in 
Figure 29.

f. In the left pane of the Preferences dialog box, click the plus sign (+) 
next to Help.

g. Select Use external browser.

h. Click Apply.

Figure 29: Preferences Dialog Box After Setting of Web Browser Options
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Configuring Proxy Servers Installing LatticeMico32 Development Tools
The Preferences dialog box should now resemble the illustration 
shown in Figure 30.

i. Click OK.

4. Activate the Mozilla Firefox browser.

5. In the Firebox browser, choose Tools > Options to activate the General 
dialog box.

6. In the Connections section of the dialog box, click Connection Settings.

7. In the Connection Settings dialog box, select Manual proxy 
configuration.

8. Select Use the same proxy for all protocols.

9. In the HTTP Proxy box, type the name of the proxy server. 

10. In the Port box next to the HTTP Proxy box, enter the port number of the 
proxy server. 

Figure 30: Preferences Dialog Box After Setting of Help Options
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The completed Connection Settings dialog box is shown in Figure 31.

11. Click OK.

Figure 31: Connection Settings Dialog Box
ispLEVER 7.1 Installation Notice 63



Configuring Proxy Servers Installing LatticeMico32 Development Tools
64 ispLEVER 7.1 Installation Notice


	ispLEVER 7.1 Installation Notice
	Installing ispLEVER Tools
	System Requirements
	Contacting Lattice Semiconductor
	Installing ispLEVER 7.1 Software for Windows
	Software Product Options
	Installation Procedure
	Installing Parallel Port Driver and USB Driver
	Selecting a License Option for Active-HDL
	Adding ispLeverDSP Paths to Matlab Search Path List
	Troubleshooting
	Licensing for the ispLEVER Software
	Finding the Installation History

	Optional Floating License Setup
	Editing the License File
	License Server Setup
	Floating License Configuration
	Troubleshooting
	Aldec Dongle Driver Installation

	Installing ispLEVER PRO
	Licensing ispLEVER PRO
	Updating IP Files with IPexpress

	Installing ispLEVER IP
	Running Multiple Versions
	Removing Old ispLeverDSP Blocksets

	Running ispLEVER from a Remote Client
	Before You Start
	Installation Procedure
	Minimal Installation Option

	Installing PAC-Designer Software
	Installing Adobe Acrobat Reader
	Updating the ispLEVER Software
	When All Else Fails

	Installing LatticeMico32 Development Tools
	Installing LatticeMico32 with ispLEVER
	Installing LatticeMico32 from a CD
	Installing LatticeMico32 from the Web Site

	Installing LatticeMico32 as Stand-Alone Software
	Installing LatticeMico32 from a CD
	Installing LatticeMico32 from the Web Site

	Starting LatticeMico32 Development Tools
	Starting LatticeMico32 Development Tools from the ispLEVER Project Navigator
	Starting LatticeMico32 Development Tools as Stand-Alone Software

	Configuring Proxy Servers
	Setting Up a Proxy Server on Microsoft Internet Explorer
	Setting Up a Proxy Server on Mozilla Firefox





<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


